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About This Book

General
This manual includes information pertinent to installation and setup of prerequisite 
third party software, automated and manual installation of Asset Master, manual 
installation of Asset Master, installation of Device Library Wizard, and necessary 
post-installation setup of Asset Master. This manual does not include information 
on site planning, engineering planning, software configuration, network design, etc., 
which can be found in other manuals.

Asset Master and other functional area softwares describes in this book is at System 
Version 5.0. The installation procedures described in this manual require Windows 
Administrator privileges.

Document Conventions
The following conventions are used for the presentation of material:

• The words in names of screen elements (for example, the title in the title bar of 
a window, the label for a field of a dialog box) are initially capitalized.

• Capital letters are used for the name of a keyboard key if it is labeled on the 
keyboard. For example, press the ENTER key.

• Lowercase letters are used for the name of a keyboard key that is not labeled on 
the keyboard. For example, the space bar, comma key, and so on.

• Press CTRL+C indicates that you must hold down the CTRL key while 
pressing the C key (to copy a selected object in this case).

The security measures described in this document, such as user access, network 
security, firewalls, virus protection, etc., represent possible steps the user should 
consider based on a risk assessment for a particular application and installation. 
This risk assessment, as well as the proper implementation, configuration, 
installation, operation, administration, and maintenance of all relevant security 
related equipment, software, and procedures, are the responsibility of the user.
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• Press ESC E C indicates that you press and release each key in sequence (to 
copy a selected object in this case).

• The names of push and toggle buttons are boldfaced. For example, click OK.

• The names of menus and menu items are boldfaced. For example, the File 
menu.

– The following convention is used for menu operations: MenuName > 
MenuItem > CascadedMenuItem. For example: select File > New > Type.

– The Start menu name always refers to the Start menu on the Windows 
Task Bar.

• System prompts/messages are shown in the Courier font, and user 
responses/input are in the boldfaced Courier font. For example, if you enter a 
value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 to 30.

Warning, Caution, Information, and Tip Icons
This publication includes Warning, Caution, and Information where appropriate 
to point out safety related or other important information. It also includes Tip to 
point out useful hints to the reader. The corresponding symbols should be 
interpreted as follows:

Electrical warning icon indicates the presence of a hazard which could result in 
electrical shock.

Warning icon indicates the presence of a hazard which could result in personal 
injury.

Caution icon indicates important information or warning related to the concept 
discussed in the text. It might indicate the presence of a hazard which could 
result in corruption of software or damage to equipment/property.

Information icon alerts the reader to pertinent facts and conditions.
8 3KXD151800R4401
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Although Warning hazards are related to personal injury, and Caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
fully comply with all Warning and Caution notices.

Terminology
A list of terms associated with Asset Master is provided in Appendix A .

Related Documentation
The following is a listing of documentation related to Asset Master.

Tip icon indicates advice on, for example, how to design your project or how to 
use a certain function

Title Description

Asset Master Version 5.0
Basic Configuration and 
Operation Manual

This manual provides details about basic 
configuration of Asset Master and basic 
operations that can be performed with Asset 
Master.

Asset Master Version 5.0
Detailed Configuration and 
Operation Manual

This document provides greater detail on all 
areas of usage of Asset Master. It is intended 
for advanced usage of Asset Master covering 
details such as SMP and CMMS setup.
3KXD151800R4401 9
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 Additional Information Related to Documentation

This book refers, at places, to 800xA System documentation and individual product 
documentation. Consider the following while referring to these documents in the 
context of Asset Master:

• Ignore all the sections and descriptions referring to 800xA specific 
configuration and operation. For example: 

– Configuration of AC800M controller and its I/O Modules

– User Interfaces like Plant Explorer Workplace, Operator Workplace etc,.

– All referrences to ControlBuilder M

• Relate 800xA user accounts to corresponding Asset Master user accounts. For 
example: “800xA Service User” corresponds to “Asset Master Service User”.

Industrial Ethernet: A Pocket 
Guide

Publisher: ISA - The 
Instrumentation, Systems, and 
Automation Society, May 2002 

ISBN: 1556177887

How to Plan, Install, and Maintain TCP/IP 
Ethernet Networks: The Basic Reference 
Guide for Automation and Process Control 
Engineers.

Foundation Fieldbus: A Pocket 
Guide

Publisher: ISA - The 
Instrumentation, Systems, and 
Automation Society, July 2002

ISBN: 1556177755

Summary of background information, tips, 
tricks, and items to note when installing, 
maintaining, or trouble-shooting.

Title Description
10 3KXD151800R4401
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Section 1  Pre-installation Setup

Introduction
Asset Master is an application for managing, configuring and optimizing assets and 
their performance. 

The key functional areas within Asset Master are:

• Device Management and Fieldbus

• Asset Optimization

The user has access to information from these areas via the Asset Master 
Workplace. Traditional engineering functions for device parameterization and 
configuration are available. In addition, Asset Master allows the user to have direct 
access to device documentation, standard operating procedures, drawings etc., 
depending on how the application has been configured.

The enabling technique for the above is the Aspect Object™ technology.

Prior to the installation of Asset Master, a set of pre-installation tasks need to be 
performed.  A number of these may already be in place on the target computer, 
nevertheless it is important to verify that all of the following are correctly set-up 
prior to installing the Asset Master software.

All interactions with the PC while meeting Software Requirements must be done 
using the same local Administrators account.  If you do not have a local 
Administrators account, contact your IT administrator.  To determine if you have 
a local Administrators account, right click on My Computer, select Manage, open 
the Users folder under Local Users and Groups, right click on your log-in name, 
and select Properties.  On the ensuing popup, select the Member Of tab.  If you 
see Administrators, then you have a local administrators account.

Asset Master is best viewed with a screen resolution of 1280x1024 pixels. 
3KXD151800R4401 11
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Hardware Requirements
For PCs used to run Asset Master, refer to Third Party HW Products Verified for 
Industrial IT System 800xA (3BSE034719) for a list of hardware.

Hardware Accessories

• IFAK PROFIBUS Adapter (is Pro USBx12)

• IFAK HART Modem (is HART USB)

• USB to RS232 9-pin convertor from Keyspan (Product Number: USA-19HS, 
Driver Version: 3.4)

• USB Hubs: Digi Hubport / 4c 10-28V DC powered USB 2.0 hub

• RS-232 to RS-485 Converters: Advantech (ADAM) 4520 Rev D2

Software Requirements

1.0 Install Microsoft Windows XP with SP2 OR Windows 2003 Server SP1.

If you want to use Micorsoft Windows XP as the operating system platform, 
install Windows XP Professional with Service Pack 2 per instructions from 
Microsoft, 

Alternately, you could also use Micorsoft Windows 2003 Server SP1 as the 
operating system platform.

2.0 Microsoft Office 2003 Applications

Microsoft Excel and Microsoft Word are used in reporting and data import 
functions within Asset Master. Install Excel and Word from the Office 2003 

For installation and configuration of the above mentioned products, please refer 
to the corresponding product manuals.

Only use the Internet Explorer that is installed with Windows XP SP2 or 
Windows 2003 Server SP1.

The U.S. English version of the operating system is required.
12 3KXD151800R4401
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suite of applications from Microsoft. Installation instructions for the these two 
can be found in the corresponding Microsoft Office 2003 installation manuals 
from Microsoft. You may install other applications from the Microsoft Office 
2003 suite, as desired.

3.0 Antivirus

Install an Anitvirus software prior to installing Asset Master. Regularly 
updated antivirus definitions from the corresponding antivirus vendor help in 
increased security.

4.0 System Backup Software

It is recommended that you install system backup software, such as Norton 
Ghost from Symantec Corporation. This can be used in taking complete 
backup of your hard drive(s) with a functional Asset Master installation. A 
fucntional system can then be completely recovered through the backup taken. 
The state of the recovered system will be same as the state of the system at the 
time of taking the backup. Installation instructions for the backup software 
should be obtained from the software vendor.

5.0 Computer Properties Set-up

Some of the Windows configurations, such as, Computer Name, Workgroup 
that this computer belongs to, Time Zone and Daylight Savings, and Regional 
Options, are automatically performed by the System Installer. Also, additional 
software and components required for a fucntional Asset Master will be 
automatically installed by the Asset Master System Installer.

5.1 Virtual Memory Configuration

A correct configuration of virtual memory can enhance performance 
considerably. As a rule of thumb the size of pagefile.sys should be physical 
RAM x 2.5 or at least 1.5 GB. As another rule of thumb, if one more disk or 
partition exists, put the pagefile.sys there. After installation and starting up the 
nodes, use standard Windows procedures, via Windows Task Manager, to 
verify that the virtual memory being used is less than the configured value of 
the virtual memory.
3KXD151800R4401 13
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5.2 Miscellaneous Windows Settings

To prevent CPU intensive redrawing of the window, disable Show Window 
Contents while dragging in the Display Properties dialog. 

5.3 Disable Energy Saver and Screen Saver

It is recommended to NOT have any Energy Saving and screen saver 
functionality activated on Asset Master nodes (especially operator Workplace 
Clients), as this might lead to longer reaction times in case of an emergency. If 
the server or workstation BIOS has an Energy Saver configuration, configure it 
on a node-by-node basis. The Windows energy saving data is user dependent.

The energy saving setting may be accessed in two ways. The BIOS setup is 
available whenever the server or workstation is powered up. It may also be 
accessed via Power Options in Windows Control Panel. The screen saver may 
be turned off in the Display Properties option in Windows Control Panel.

5.4 Disable Windows Firewall

The supported Windows Operating Systems come with a Windows Firewall 
component that must be disabled. Use standard Windows procedures to disable 
Windows Firewall on the Asset Master node.

5.5 Disable Web Browser Popup Blocker

Some third party software may offer a web browser popup blocker. Do not use them 
with the thin client portions of the integrated applications (specifically Asset 
Optimization), since these applications open child window browsers to display 
application data for the user. If a popup blocker is being used on a web browser, 
disable it during use of these web based applications.

5.6 Disable Virus Checking Software

If virus checking software is installed, disable it until after Asset Master is installed 
and configured (post installation).
14 3KXD151800R4401
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5.7 Disable Automatic Updates

1. If the selected Windows Operating System comes with an Automatic Updates 
component, it must be disabled. Select:

Start > Control Panel > Automatic Updates

2. Enable Turn off Automatic Updates and click OK.

Ensure that all Windows Operating System Service Packs mentioned are installed 
in order to access this functionality.

Make sure that all the pre-requisite softwares mentioned above are properly 
installed, and the computer meets the minimum hardware requirements to take 
maximum advantage of Asset Master. Asset Master may not function effectively 
if the pre-requisites are not met.
3KXD151800R4401 15
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Section 2  Installing Asset Master

The automated installer for Asset Master does all the work of configuring Windows 
and installing the necessary software for Asset Master. This section describes in 
detail the installation steps for installing Asset Master.

Asset Master Installer is an application that automatically installs the necessary 
software and components for Asset Master and configures the Windows system.

When the Asset Master DVD is inserted into the drive, a screen similar to the one 
shown in Figure 1 is automatically launched. Alternately, the Asset Master System 
Installer is located in the folder ‘System_Installer’ on the DVD. Double-click on 
setup.exe to start the installation of Asset Master System Installer.

The Asset Master System Installer does not, at this point, create the Asset Master 
Installer User account in Windows. Hence, login to Windows with a user having 
‘Administrator’ rights.
3KXD151800R4401 17
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Figure 1. IndustrialIT Asset Master Splash Screen
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Table 1. Button Descriptions

Button Description

Clicking on this button opens the Asset 
Master 5.0 Installation Manual.

Clicking on this button launches ABB Asset 
Master Installer Installation Wizard.

Clicking on this button opens the Asset 
Master Release Notes.

Clicking on this button closes closes the 
splash screen.

To open “Installation Manual” and “Release Notes”, Adobe Acrobat Reader 7.0 
must be installed. If the reader is not already installed, click on “Install Acrobat 
Reader 7.0” and follow the on screen instructions to install the reader.
3KXD151800R4401 19
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When you begin the installation by clicking on Install Asset Master, a welcome 
screen similar to the one shown in Figure 2 will appear, listing “ABB Asset Master 
System Installer” as the software about to be installed. Let the checkbox next to it 
remain ticked. Click on the “Install” button.

Figure 2. Welcome to ABB Asset Master Installer

The wizard installs all the necessary system installer components. If the dot net 
framework is not installed, a dialog similar to the one show in Figure 3 will pop up. 
Click Yes and follow the instructions on the screens to install the Dot Net 
framework.
20 3KXD151800R4401
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Figure 3. Install Dot Net Framework Dialog

Once these components are installed successfully, the installer application exits.

You can now start setting up a system, which is described in the next section Section 
3, Setup of Asset Master
3KXD151800R4401 21
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Section 3  Setup of Asset Master

Starting the Asset Master Setup

Through the Asset Master System Installer, you can now setup Asset Master. From 
the Start menu, select Program > ABB Asset Master System Installer > Setup a 
New System. 

A welcome screen similar to the one shown in Figure 4 is displayed. Click on Next 
to continue.

Figure 4. Asset Master Installer Welcome Screen

Please ensure that Asset Master DVD is inserted into the drive prior to starting the 
installation.
3KXD151800R4401 23
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Asset Master prepares for the installation, during which you’ll see a screen similar 
to the one shown in Figure 5, indicating the progress. Once the preparation is 
complete, the Next button is enabled. Click on the Next button to continue.

Figure 5. Initializing Asset Master Installation
24 3KXD151800R4401
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In the resulting screen, similar to the one shown in Figure 6, provide the details as 
per the information shown in Table 2. System and Service Account Settings.

Figure 6. Asset Master Settings and Service Account Details

Table 2. System and Service Account Settings

Field Description

Hostname Sets the name of the machine for 
indentification in a network.

Recommended Hostname is “AMSRV1”.

IP Address Sets the IP (Internet Protocol) Address (A 
unique number that identifies a device in a 
network) of the machine to the one specified in 
this field.

The recommended IP address for the node is 
‘192.168.1.24’.
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Figure 7. Add / Edit Users

Subnet Mask Provide the subnet mask on which your 
network is located.

The recommended subnet mask 

Workgroup Name The machine, on which Asset Master is 
installed, must be a part of a workgroup. 
Provide the name of your workgroup. 

Recommended workgroup name is 
“AMGROUP”.

Add/Edit This takes you to another screen where in you 
can add users to existing user groups of Asset 
Master as show in Figure 7.

Table 2. System and Service Account Settings

Field Description
26 3KXD151800R4401
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Edit Users

To edit any user information double-click on the corresponding user row in the table 
displayed. This populates the user data in the corresponsing fields. Edit the 
information and click Apply. If any modification done needs to be cancelled while 
editing the information, press Cancel. The default Passwords for all users is 
“Asset123#”.

Add Users

To add a new user, enter the information in the fields provided, as described in the 
Table 3. User Information, and click on New User.

Once all the correct information is entered, click Exit to return to the main 
installation screen. Click on Next.

Table 3. User Information

Fields Description

User ID The id of the user.

Full User Name Full name of the user for whom the id 
is created.

Password Password corresponding to the user.

Confirm Password Confirm the password provided in the 
password. 

Group1 to Group 6 The user group that the user is 
affiliated.

Please ensure that any new user being added is part of "IndustrialIT user" user 
group. 

If the new user is required to be a part of Asset Master Administrator, then the 
user should be a part of "IndustrialIT Admin" group.

If the new user is required to be a part of Windows Administrator, then user 
should be a part of "Administrators" group.
3KXD151800R4401 27
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The next screen as shown in Figure 8 dislays the terms and conditions for the use of 
ABB Software. Read the terms and conditions carefully and check the box to accept 
the terms and conditions.

Figure 8. License Agreement Acceptance

Once you accept the terms and conditions of the license agreement, click on Next 
button.
28 3KXD151800R4401
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In the resulting screen, similar to the one shown in Figure 9, confirm the start of the 
system installation by clicking on the Finish button.

Figure 9. Confirm Product Installation

After clicking on the Finish button, Asset Master installation process is started as 
shown in Figure 10. During this process, the setup will automatically:

• configure Windows for Asset Master

• verify that required components are installed

• install Asset Master

• configure Asset Master

• and generate a system report.

The current action or progress of the installation is indicated when the 
corresponding action turns green. 
3KXD151800R4401 29
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Figure 10. Asset Master Windows Configuration Wizard
30 3KXD151800R4401



Section 3  Setup of Asset Master Configuring Windows for Asset Master
 

Configuring Windows for Asset Master

The Asset Master installation process begins with the Asset Master Windows 
Configuration Wizard, as shown in Figure 10. The wizard will configure the 
following:
• Network Adaptors
• Windows Components
• Windows Users and User Groups
• Windows Services

Click on the Next button to continue with the Windows configuration.

The next screen displays the available network adaptors in your machine, in a screen 
similar to the one shown in Figure 11.

Figure 11. Asset Master Network Settings

Select the network adaptor from the list that you want to use with Asset Master. The 
adapter can be moved between ‘Local Area Connecton’s, by drag-and-drop. Here 
'Local Area Connection – broadcom…' is selected. If you want to select the 'local 
3KXD151800R4401 31
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area connection 2' adapter, drag and drop the "Adapter1" to the required location.. 
Click on the Next button to continue.

A dialog similar to the one shown in Figure 12 pops up. Click OK  to confirm or 
Cancel to go back to the selection screen.

Figure 12. Network Settings

Once the Windows configuration is complete, a screen similar to the one shown in 
Figure 13 is displayed. 

Figure 13. Apply Settings

Click on Next button to complete Windows configuration, and begin the Windows 
Components Configuration.
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For some of the components to be installed, it is necessary to have the Windows 
Operating System installation disk. The installer will popup a dialog, similar to the 
one show in Figure 14, prompting for the Windows installation CD. Remove the 
DVD from the PC and insert the Windows installation CD and click OK.

Figure 14. Windows Installation CD Prompt

Once the windows components are installed, replace the Windows installation CD 
in the drive with the Asset Master DVD and continue the installing Asset Master.
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A screen similar to the one shown in Figure 15 displays the progress, while the 
wizard gathers necessary details for configuring the Windows components. Click on 
the Next button to continue.

Figure 15. Components Configuration Progress
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Confirm the start of the components configuration by clicking Next in a screen 
similar to the one shown in Figure 16.

Figure 16. Configuring Windows Components
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The next screen, as shown in Figure 17, displays the “user groups” that will be 
added to your system. Click on the Next button to continue.

Figure 17. Adding Asset Master User Groups
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The next screen, as shown in Figure 18, displays the “users” that will be added to 
your system. Click on the Next button to continue.

Figure 18. Adding Asset Master Users
3KXD151800R4401 37
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The next screen, as shown in Figure, displays the Asset Master service user name. 
To continue with the installation without changing the Asset Master service user 
name or the corresponding password, click on Next.

Figure 19. Service Account Configuration

To change the Asset Master service account user name and/or the corresponsing 
password click on the “Advanced >>” button.
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In the resulting screen, as shown in the Figure 20, provide a new username for the 
Asset Master service account, with the corresponding passwords and click on Next.

Figure 20. Change Service Account Configuration
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Once the wizard completes the components configuration, a screen similar to one 
shown in Figure 21 is displayed, prompting for a machine restart. 

Figure 21. Asset Master System Restart

Click on the Finish button to restart the machine.

Follow the information in the popup dialog, as shown in Figure 22. 

Figure 22. Asset Master System Setup Restart Information

Once the machine reboot is complete, login as “AMInstall” user. The default 
password for this user is “Asset123#”.
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Verifying the Base System
The setup automatically continues by verifying that the required components are 
installed. The Asset Master Verifier Tool Wizard, similar to the one shown in 
Figure 23, is displayed. Click on the Next button to continue.

Figure 23. Asset Master System Verifier Tool Wizard

Installation of some components may require a machine restart. Restart the 
machine when prompted. Login as ‘AMInstall’ user. The dafault password for 
the user is ‘Asset123#’
3KXD151800R4401 41
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In the resulting screen (Figure 24), the verifier tool checks whether the current 
“AMInstall” has been granted “Administrator” rights on the system.

Figure 24. Check for Administrator Rights

A red cross mark indicates that the current user does not possess administrator 
rights, and hence cannot install the software on the system. In this case, exit from 
the current installation and logoff from the PC. Login to the system as 
“Administrator” and grant the necessary rights to the “AMInstall” user. Refer to the 
Windows documentation on how to grant rights or contact your System 
Administrator. Once the administrator rights are granted to the “AMInstall” user, 
then login to the system again as “AMInstall”. To continue with the installation, 
from the Start menu go to Programs > ABB Asset Master Installer > Continue 
Installation. The installation will continue from the point where it had stopped.

A green tick mark indicates that the user has administrator rights and can proceed 
with the installation. Click on the Next button to continue.
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In the next screen as shown in Figure 25, the Asset Master Verifier Tool Wizard 
checks for hardware compliance. A green tick indicates that a hardware requirement 
is met. An exclamation denotes that a hardware requirement does not meet the 
minimum requirement and that Asset Master will nevertheless work but with 
decreased performance. A red cross indicates that a hardware requirement is 
incompatible for the effective functioning of Asset Master.

Figure 25. Check for Hardware Requirements

Click on Next button to continue. 

In the resulting screen, similar to the one shown in Figure 26, the Asset Master 
Verifier Tool Wizard checks for installed Microsoft Software Components, that the 
Asset Master will use. If any of the listed software components are already installed, 

Make sure, at least, that the minimum hardware requirement is met. This will 
ensure, at least, minimum performance of Asset Master.
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the status of the software component is ticked green. If any of the software 
components is not installed, the status indicates a red cross against that component.

Figure 26. Check for Installed Microsoft Components

An Install button is displayed next to the status of the software component that is 
not installed, similar to what is shown in Figure 26. Click on the Install button to 
install the missing Windows component. Once the status of all the components is 
ticked green, the “Next” button is enabled. Click on the Next button to continue.
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During the installation of some componenets (Eg. .NET Framework 1.1 SP) 
screen similar to the one below is displayed.

Click on Ignore to continue the installation.
3KXD151800R4401 45



Verifying the Base System Section 3  Setup of Asset Master
 

In the resulting screen, similar to the one shown in Figure 27, the Asset Master 
Verifier Tool Wizard checks for additional software components installed, that Asset 
Master system will use. If any of the listed additional software component is already 
installed, the status of the software component is ticked green. If any of the software 
components is not installed, the status indicates a red cross against that component.

An Install button is displayed next to the status of the software component that is 
not installed, similar to what is shown in Figure 27.

Figure 27. Check for Additional Components

Click on the Install button to install the missing software component and follow the 
installation instructions. Once the status of all the software components is ticked 
green, the “Next” button is enabled. Click on the Next button to continue.
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In the next screen, similar to the one shown in Figure 28, the Asset Master Verifier 
Tool Wizard checks for installed hotfixes. 

During the installation of ifak PRO Multidriver, a screen similar to the one show 
below is displayed.

Check the USB check box and uncheck all other check boxes and click Next to 
continue.

If, during the process of installing the missing components, the Windows 
Operating System CD is to be inserted into the drive, then once the installation of 
the missing components are complete, replace the CD in the drive with Asset 
Master DVD. If a dialog similar to the one shown in Fig is displayed, then insert 
the Asset Master DVD into the drive and click OK.
3KXD151800R4401 47



Verifying the Base System Section 3  Setup of Asset Master
 
Figure 28. Check for Microsoft Hotfixes

If the listed hotfixes are already installed then the status of the corresponding 
hotfixes are ticked green. If any hotfix is not installed, the status of the 
corresponding hotfix is marked with a red cross and an Install button is displayed 
next to it. Click in the Install button to install the missing hotfix, and follow 
instructions on the screen. If you are prompted for a machine restart, restart the 
machine and continue with the system setup.

Once the status of all the listed hotfix is ticked green, the “Next” button is enabled. 
Click on Next button to continue.

A Security Warning dialog (Figure 29) is displayed prompting you to download and 
install any latest security related hotfixes, which Microsoft releases from time to 
time.
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Figure 29. Microsoft Hotfixes Security Warning

If your Windows operating system is already updated with the latest security 
hotfixes, and you want to continue the installation click on the No button, and 
continue.

If any new security hotfixes from Microsoft are available, then click on the Yes 
button to exit from the system setup. Install the security hotfixes from Microsoft, 
and then continue with the system setup by selecting Start > Programs > ABB 
Asset Master Installer > Continue Installation.

It is recommended that Asset Master be updated with the latest security hotfixes 
all the time to ensure necessary levels of security. The recommended ABB 
certified hotfixes are available for download at http://solutionsbank.abb.com.
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Once the base system verification process is complete, a screen similar to the one 
shown in Figure 30 is displayed, with a report of the verification.

Click on Save to save the report in a text file.

Figure 30. Asset Master System Report

Click on the Finish button to complete the Asset Master verification process.
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Installing Asset Master
The system setup is now ready to install the Asset Master software components. In a 
screen, similar to the one shown in Figure 31, all the ABB software components that 
will installed for Asset Master are displayed. All listed software are automatically 
installed once the installation begins.

Figure 31. Install Asset Master

Click on the Install button to begin the installation of the ABB software 
components for Asset Master. During this time, you will see the software 
component being installed along with the installation progress of that component. 
After all the components are installed, the installer will prompt for a reboot of the 
machine. Click on the OK button to reboot the machine.
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Configuring Industrial IT 800xA
After Installing Asset Master, the installer will start configuring Asset Master. A 
screen similar to the one shown in Figure 32 would appear. Click on Next to 
continue.

Figure 32. Asset Master Configuration - Welcome Screen
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In the resulting screen (Figure 33), the installer encourages you to take a backup of 
the system, using a disk imaging software such as Norton Ghost from Symantec 
Corporation.

Figure 33. Create System Backup

In the unlikely event of a system crash, this backup can be used to restore your 
system to the state at which the backup was taken, saving significant time bu not 
having to install Asset Master up to this stage. 

To take a backup, exit the current installation by clicking on the Cancel button. 
Press “Esc” and click on Yes button in the popup dialog to exit the current 
installation. Take a backup of the Asset Master hard disk. After the backup is 
complete, continue the installation through the Start > Programs > ABB Asset 
Master Installer > Continue Installation. 
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Once the installer starts, move on to the next screen by click on Next. A screen 
similar to the one shown in Figure 34 displays an important note on Microsoft 
ActiveX Controls. Read the information carefully, click on Next button.

Figure 34. An Important Note on Microsoft ActiveX Controls
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In the resulting screen, similar to the one shown in Figure 35, provide the Asset 
Master license.

Figure 35. Enter Asset Master License

Click on the link License Entry. Depending on the security settings of the Internet 
Explorer, a popup might appear displaying information about an ActiveX control 
trying to open, such as the one shown in Figure 36.
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Figure 36. ActiveX Control Notification of Internet Explorer

Click on Yes to continue opening the ABB Lincese Tool. When the License Entry 
tool opens, click Next in the Asset Master Configuration Wizard to read further 
instructions on entering the license file, which displays a screen similar to the one 
shown in Figure 37.

Figure 37. Enter Asset Master License
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Follow the steps mentioned in the screens, as shown in Figure 35 and Figure 37, or 
read the following instructions to load the license file.

1. Open Start > (All) Programs > ABB Industrial IT 800xA > System > 
Licensing > License Entry.

2. From the File menu, of the License Entry tool, select Load / Replace 
Licenses....

3. This opens a file chooser dialog. Browse and select the corresponding license 
file (.sla file) for Asset Master.

4. Click on Open button.
This will load the licenses from the .sla license file into your system and 
populate the tree view in the License Entry tool.

5. Exit the License Entry program.

Click on the Next button to advance to the next screen.

If you do not have the license file, and you want the advantage of Asset Master, 
please get in touch with ABB Customer Support for your region to obtain it.
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In the resulting screen, as shown in Figure 38, perform the steps listed below.

Figure 38. Enter License Server Node Name

1. Open Start > (All) Programs > ABB Industrial IT 800xA > System > 
Licensing > License Status Viewer.

2. Verify that the Connection Status, which is displayed at the bottom of the 
screen as shown, is marked No Error.

3. Exit the License Status Viewer program.

Click on the Next button to move to “System Software User Settings” screen 
(Figure 39). 
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In this screen you configure Windows Users and User Groups that are to be used by 
Asset Master. 

Figure 39. System Software User Settings

Click on Configure User Settings button. Depending on the security settings of the 
Internet Explorer, a popup might appear displaying information about an ActiveX 
control trying to open.

Click on the Yes button to continue configuring the user settings for Asset Master. 
The User settings will be set to ‘AMServUser’, an Asset Master Service Account, 
as per the parameters specified during earlier System Installation steps.

A progress window appears indicating the progress of the operation. A message will 
popup indicating successful completion of the task. You can then click on the Next 
button to move on to the next screen (Figure 40).
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In the event that the ActiveX control does not open, follow the instructions steps 
mentioned below. 

1. In the Asset Master Configuration Wizard, select System Software User 
Settings and click on Next.

2. Fill in the appropriate Service Account user and group information. Select the 
Autostart and Application Logging options if required and then click on Next 
button.

3. A list of the configurations to be carried are displayed. Click on the Finish 
button to confirm the settings.

4. In the Aspect Configuration Wizard click on the Next button and follow the 
instructions on that page.

Once the User settings are complete, click on Next to set the Network Access 
Security option.
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Figure 40. Configure Network Access Security Option

Click on Configure Local Settings button. Depending on the security settings of 
the Internet Explorer, a popup might appear displaying information about an 
ActiveX control trying to open.

Click on the Yes button to continue and automatically configure the local settings 
for Asset Master.

If the operating system of the machine is Windows XP, continue with this step. If 
your operating system is not Windows XP, but Windows 2003, then skip this step 
and click on the Next button to configure daylight savings and power settings for 
your laptop.
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In the event that the ActiveX control does not open, follow the instructions steps 
mentioned below.

1. Open “Administrative Tools” from Start menu, Settings > Control Panel > 
Administrative Tools and open Local Security Policy.

2. Once the Local Security Settings configuration window opens, select Local 
Policies > Security Options.

3. Double-click on Network access: Sharing and security model for local 
accounts.

4. Select Classic - local users authenticate as themselves from the list box and 
click on OK.

5. Close the Local Security Settings window.

Once the Network Access Security options is configured, click on the Next button 
to configure daylight savings and power settings.
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Figure 41. Configure Daylight Savings and Power Settings

To set the daylight savings option on your machine, follow these steps:

1. From the Start menu select Settings > Control Panel and open Date and 
Time.

2. Set the appropriate Time Zone to match your region.

3. Check the box Automatically adjust clock for daylight changes if this 
applies to your region.

4. Click on the OK button to close the window.

Click on Configure Power Mode button similar to the one shown in Figure 41. 
Depending on the security settings of the Internet Explorer, a popup might appear 
displaying information about an ActiveX control trying to open.
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Click on the Yes button to continue and configure the power mode for you laptop.

In the event that the ActiveX control does not open, follow the instructions steps 
mentioned below to configure the power mode for your laptop.

1. From the Start menu select Settings > Control Panel and open Power 
Options.

2. Select the Power Schemes tab.

3. Select the “Power schemes” to Always On.

4. Select Never for the remaining options: Turn off monitor, Turn off hard 
disks and System standby.

5. Click on the OK button to close the window.

Once the daylight savings and power options are set, click on the Next button to set 
the regional options.

Perform these steps for all users in the ‘IndustrialITUser’ Group.
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Figure 42. Configure Regional Options

Click on Set Regional Settings button as shown in Figure 42. Depending on the 
security settings of Internet Explorer, a popup might appear displaying information 
about an ActiveX control trying to open.

Click on the Yes button to continue setting regional settings and follow steps 2 and 3 
mentioned below.
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In the event that the ActiveX control does not open, follow the instructions steps 1 
through 3 mentioned below to set the regional settings.

1. From the Start menu select Settings > Control Panel and open Regional and 
Language Options.

2. In the Regional Options tab, set the “Standars and formats” to English 
(United States).

3. Click on the OK button to close the window.

Once the regional options are set, click on the Next button to disable Windows Time 
service.
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Figure 43. Disable Windows Time Service

Click on Disable Windows Time Service button as shown in Figure 43. Depending 
on the security settings of the Internet Explorer, a popup might appear displaying 
information about an ActiveX control trying to open.

Click on the Yes button to continue and automatically disable the Windows Time 
service.
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In the event that the ActiveX control does not open, follow the instructions steps 
mentioned below.

1. From the Start menu select Settings > Control Panel > Administrative Tools 
and open Services.

2. From the list of service, double-click on the service named Windows Time.

3. In the resulting window, click on the Stop button to stop the service if it is 
running. Select Disabled from the Startup type drop down list.

4. Click on the OK button to close the window.

Once the Windows Time service is disabled click in the Next button. 
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The resulting screen similar to the once shown in Figure 44 provides instructions to 
configure FOUNDATION Fieldbus.

Figure 44. Configure FOUNDATION Fieldbus

Follow these steps to manually configure FOUNDATION Fieldbus:

1. From the Start menu select (All) Programs > ABB Industrial IT 800xA > 
Device Mgmt - FF > FOUNDATION Fieldbus > Configure. This opens the 
“Configure” program for FOUNDATION Fieldbus Device Integration. From 
the list in the Actions column, select OPC Server FF.
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2. Enter a number in the New Resource ID text box.

3. Click on the OK button to commit the configuration.

Once the FOUNDATION Fieldbus is configured, click on the Next button to see 
instructions on restoring Asset Master.

The resource Id for the OPC Server FF can range from 1 to 255, but Filedbus 
Builder FF has the fixed resource Id 21 for Fieldbus Builder FF. This Id cannot 
be changed, and hence 21 as resource Id is not recommended as a new resource 
Id. 

The recommended resource ID is 2.
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Figure 45. Restore Asset Master

Follow these steps to restore the Asset Master system:

1. From the Start menu select (All) Programs > ABB Industrial IT 800xA > 
System > Configuration Wizard.

2. From the listed actions in the Configuration Wizard, select Restore System 
and click on the Next button.

3. Click on the Select Path button. In the “Select Path” dialog click on Add 
button to locate Asset Master System Backup. Browse to the folder ‘\Asset 

The process of restoring the system might take a few minutes to a few hours 
depending on the PC hardware capabilities.
3KXD151800R4401 71



Configuring Industrial IT 800xA Section 3  Setup of Asset Master
 

Master\Asset Master System Backup’ on the Asset Master DVD, and click 
on the OK button.

4. In the “Select Path” dialog a default path is displayed. Select this path and then 
click on the OK button to close the dialog.

5. In the Configuration Wizard, the backup location with the date of the backup is 
displayed. Select the listed backup and click on the Next button.

6. In the subsequent screens of the Configuration Wizard, use the default values 
and click on the Next button.

7. In the resulting screen, verify the summary of the selections made for the 
system restore. When the summary report is in order, click on the Finish button 
to start the system restore process.

Once the system is restored completely, you might be prompted for a machine 
restart. Restart the machine and check the following indicators to verify whether the 
system is running:

1. Hover the cursor over the System Status icon in the Windows Notification area, 
near the lower right corner of the screen. The popup message should indicate 
that the system is Enabled.
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2. Wait until the system is running and the icon turns green. It might take a few 
minutes, depending on your machine, for the system to be created and started.

Figure 46. Verify Whether System is Running

Once the system restore is complete and verified, click on the Next to button to 
advance to Alarm Logger Configuration.

A screen, similar to the one shown in Figure 47 is displayed, wherein instructions 
are provided for configuring Alarm Logger.

Perform the below mentioned steps prior to continuing with the Alarm Logger 
Configuration:

1. Open Asset Master workplace:
From the Start menu, select ABB Industrial IT 800xA > System > 
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Workplace
- OR -
Double-click on “My ePlant” icon on the desktop.

2. From the Service Structure, select Services -> Alarm Logger Service -> 
Basic, Service Group.

3. Select “Service Group Definition” aspect.

4. Open the “Special Configuration” tab.

5. From the “Logger Configuration Name” drop-down box, select “Common 
Alarm & Event Logger Configuration” and click Apply.

Figure 47. Configure Alarm Logger

Follow these steps to configure Alarm Logger:
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1. Add and configure a printer that is connected to the machine where Asset 
Master is installed.

2. Open Asset Master workplace:
From the Start menu, select ABB Industrial IT 800xA > System > 
Workplace
- OR -
Double-click on “My ePlant” icon on the desktop

3. From the Service Structure, expand Services and navigate through Alarm 
Logger, Service --> Basic, Service Group --> Alarm 
Logger_Basic_AMSRV1, Service Provide. Open Service Provider 
Definition aspect and select Special Configuration tab.

4. In the logger configuration, from the Printer Name drop down box which lists 
printers configured on the machine, select a printer. You should now see the 
Logger State change from Not Configured to Ready.

Once the Alarm Logger configuration is complete, click on Next button in Asset 
Master Configuration Wizard.

A screen, similar to the one shown in Figure 48 is displayed, wherein instructions 
are provided for verifying whether all Asset Master related servers are running.
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Figure 48. Verify Services that are Running

Follow these steps to verify whether all the servers are running.

1. Open the Service Connection Viewer by double-clicking on the System 
Status icon in the Windows notification area.

2. Check whether the status of all the listed services are green. If the status of any 
service is not green, then more information is available in the System Status 
Viewer. 

3. Opening the Asset Master is described in the next step. In the Asset Master, 
open Service Structure, select Services and open System Status Viewer 
aspect. Make a note of any service which is not running, and verify them when 
you are through with the configuration.
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4. Subsequent configurations are performed within Asset Master. Open Plant 
Explorer from the Start menu and select (All) Programs > ABB Industrial IT 
800xA > System > Workplace. Select Asset Master Workplace and click 
Open.

Once it is ensured that all the services are running, with their corresponding status 
green in the Service Connection Viewer, and the Asset Master is open, click on the 
Next button to see how to see how to configure Asset Optimization settings. 

A screen similar to the one shown in Figure 49 is displayed describing steps to 
configure Asset Optimization.
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Figure 49. Verify Asset Optimization Settings

Follow these steps to configure Asset Optimization settings:

1. Open Asset Master Workplace and navigate to Control Structure.

2. Open Asset Optimization, Asset Optimization Aspect object and Select 
Asset Optimization Configuration Properties aspect.

3. In the aspect view, ensure AOWebServerNode property value is the same as 
Asset Master NodeName.

Once the Asset Optimization configuration is complete, click on Next button in 
Asset Master Configuration Wizard.
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A screen similar to the one shown in Figure 50 is displayed with steps to associate 
user groups. Refer to Table 4. User Groups Mapping to see the user group mapping 
between Windows and Asset Master.

Figure 50. Associate User Groups

Table 4. User Groups Mapping

Asset Master User Group Windows User Group

Everyone Industrial IT User

Administrators Industrial IT Admin

Application Engineers Application Engineers

System Developers System Developers
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The following steps describe how to associate Windows User Groups with the User 
Groups of Asset Master:

1. In the Asset Master Workplace, select the User Groups object from the User 
Structure list.

2. Select a user group object from the list of objects under User Groups. Begin the 
associations from the Everyone user group and open its User Group 
Definition aspect and click on the ‘Associate with Windows Group...’ button.

3. In the dialog window that opens, select the corresponding Windows group and 
click on OK and then click on Apply.

4. Users can be added from the Members tab by clicking on the ‘Synchronize 
with Windows Group...’ button.

5. Repeat steps 2 through 4 for all user group objects that have a corresponding 
Windows user group.

Once user group association is complete, click on the Next button to see how to 
configure time service.

System Engineers System Engineers

Operators Operators

Maintenance Technicians Maintenance Technicians

Maintenance Supervisors Maintenance Supervisors

Maintenance Engineers Maintenance Engineers

The following steps are optional and they describe how Windows Groups can be 
associated with the User Groups in the Asset Master System.

Table 4. User Groups Mapping

Asset Master User Group Windows User Group
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Figure 51. Configure Time Service

The following steps describe how to configure the time service in Asset Master.

1. In the Asset Master, select Service Structure.

2. Expand Services and select Time, Service. In the Aspect view select Service 
Definition.

3. Select the Special Configuration tab

a. Make sure that the check-box for Server Running is checked.

b. Make sure that the check-box for Clients allowed to set time is 
unchecked.

c. Make sure that the check-box for Enable external clock master function 
is unchecked.
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4. Click on the Apply button to save the changes.

Once the time service is configured in Asset Master, click on the Next button to see 
how to configure DCOM for HART multiplexer Connect on a client node.

Figure 52. DCOM Configuration for HART Multiplexer Connect
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Table 5. DCOM Settings describes the correct DCOM (and COM+) settings for 
installed components based on node types. 

The following steps describe DCOM configurations for a HART Miltiplexer 
Connect:

1. From the Start menu, select Run and enter dcomcnfg and click on the button 
OK.

2. From the Console Root select Component Services > Computers > My 
Computer > DCOM Config.

3. Right-click on the HC component and select Properties.

4. Select the tab named Identity, in the Properties window, and set the indentity to 
This User (Asset Master service account).

5. Confirm the changes by clicking on OK button and close the window.

Table 5. DCOM Settings

Type Installed Components Settings

DCOM DeviceManagementServer Identity: This User (Asset 
Master Service Account)

ABB Fieldbus OPC-Server DA

HC

The following changes must 
be adapted in Properties 
View > Location tab to: 

HART Server node: Run 
application on this computer. 

Other nodes: Run Application 
on the following computer. 

Insert the IP address of 
the system node where 
the HART Server is 
running.

COM+ DMSComPlus
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Once you have made above mentioned DCOM configuration, click on the Next 
button. This will result in a screen similar to the one shown in Figure 53.

Figure 53. Restore HART Modem and Profibus Adapter Objects

Perform the following steps to use ifak HART modem and PROFIBUS adapter. 
These steps can be performed later on, but are must before using the modem and the 
adapter. 

To use Device Library Wizard, refer to Basic Configuration and Operation manual.

1. Launch Device Library Wizard and navigate to Extract Device Types. Browse 
and select ifak HART modem object type 
(ifak_System_isHRT_USB_V1_1_HART) located on Asset Master DVD under 
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Device Management & Fieldbuses\PROFIBUS & HART Communication 
Devices\ifak Object Types. 

2. Navigate to Select System > Restore Device Types > HART. Enable Show 
All and select HART modem object type.

3. Click Finish to install ifak HART modem DTM.

4. Repeat steps 1 to 3 to install PROFIBUS adapter object type 
(IFAK_System_is_Pro_USB_V1_1_DP). 

Click on the Next button to advance to the next screen.

Refer to object type release notes located in the extract folder. 

Contact ifak for DTM licenses 
3KXD151800R4401 85



Configuring Industrial IT 800xA Section 3  Setup of Asset Master
 
Figure 54. Asset Master System Setup Complete

Click on the Finish button to complete the configuration of Asset Master. 

A popup is displayed with a message prompting to close the window. 
Figure 55. Window Close Warning - Internet Explorer [CloseWindow]

Click on the Yes button to continue.
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Generating System Report
Asset Master System Report Wizard will start with a screen similar to the one 
shown in Figure 56. 

Figure 56. System Report Wizard - Welcome Screen

Click on the Next button, which pops up a screen similar to the one shown in 
Figure 57.
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Figure 57. Folder Browser for placing Asset Master Setup Report

Select the folder where you want the report to be placed and click in the OK button. 
In the system report wizard, similar to the screen in Figure 58, click on the Next 
button to generate the report.
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Figure 58. Asset Master System Report Wizard

Once the report generation is complete, a screen similar to the one shown in 
Figure 59 is presented. 
3KXD151800R4401 89



Generating System Report Section 3  Setup of Asset Master
 
Figure 59. View System Report

To view the system report, check the box against View System Report and click on 
the Finish button. The generated report is displayed which you can save for future 
reference. A message similar to the one shown below pops up indicating successful 
installation and configuration of Asset Master.

Figure 60. Asset Master Installation & Configuration Completion Dialog

Congratulations! Your Asset Master node is successfully installed and configured.
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You now need to install the DTMs of IFAK HART and IFAK PROFIBUS modems. 
See Section 4, Post Installation for instructions.
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Section 4  Post Installation

IFAK DTM Installation
To install the Device Type Managers (DTMs) for IFAK HART modem and IFAK 
PROFIBUS modem, you first need to extract the device object types and the restore 
them through Device Library Wizard.

The following sections describes the DTM installation procedure:

• Extract Device Object Types on page 94

• Restore Device Object Types on page 98

The prodecure for installing the DTMs is similar for both HART and PROFIBUS 
modems. 

The DTM installation procedure described in this section applies to both 
PROFIBUS/HART modems.
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Extract Device Object Types

The following steps describe how to extract device object types of IFAK 
HART/PROFIBUS modems.

1. From the Start menu, select (All) Programs > ABB Industrial IT 800xA > 
Device Mgmt > ABB Device Library Wizard. The Device Library Wizard 
screen, similar to the one shown in Figure 61 opens.

Figure 61. Select Extract Device Types

Select Extract Device Types and click on Next button.
94 3KXD151800R4401



Section 4  Post Installation Extract Device Object Types
 

2. In the resulting screen, similar to the one shown in Figure 62, Click on the 
Browse button.

Figure 62. Browse and Select the Device Object Type File

On the Asset Master DVD, locate the folder Device Management & 
Fieldbuses > PROFIBUS & HART Communication Devices > ifak Object 
Types and execute:
2PAA101492_B_en_DeviceObjectType_ifak_System_isHRT_USB_V1_1_HAR
T.exe for HART modem and 
2PAA101569_B_en_DeviceObjectType_IFAK_System_is_Pro_USB_V1_1_DP.
exe for PROFIBUS modem.

There could be periodical updates of Device Object Types released. The latest 
device objcet types can be found at ABB Solutions Bank.
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3. Select the Device Object Types from the list, as shown in Figure 63, and click 
on Next button.

Figure 63. Select Device Object Type from the List
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4. In the resulting screen, similar to the one shown in Figure 64, review the 
Device Object Types to be extracted and click on Next button to continue 
extraction.

Figure 64. Device Object Type Selection Summary

Once the Device Object Type is extracted, click on the Main Menu button to 
return to the main menu of Device Library Wizard.
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Restore Device Object Types

1. In the resulting screen, similar to the one shown in Figure 65, select “Select 
System” and click on Next button.

Figure 65. Select System
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2. From the list of systems in the resulting screen, as shown in Figure 66, select 
“Asset Master System” and click on Next button.

Figure 66. Select Type of System
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3. From the list of actions in the resulting screen, as shown in Figure 67, select 
“Restore Device Types” and click on Next button.

Figure 67. Select Action
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4. The resulting screen, similar to the one shown in Figure 68, lists the Fieldbus 
Protocols. Selec the protocol corresponding to the Device Object Type to be 
restored and click on Next button.

Figure 68. Select Fieldbus Protocol
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5. In the resulting screen, similar to the one shown in Figure 69, select from the 
list of Device Object Types that are to be restored by checking the box against 
the corresponding device. Click on Next button to continue.

Figure 69. Select Device Object Types
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6. The resulting screen, similar to the one shown in Figure 70, displays a 
summary of the object types being restored. Review the report and then click 
on Next button to continue to restore.

Figure 70. Device Object Types Summary Report

7. The object type restore process invokes the DTM installer during restoration. 
Follow the instructions on screen to arrive at the screen similar to the one 
shown in Figure 71.
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 Figure 71. DTM Customer and License Information

Refer to the back of your IFAK CD cover, and enter the Company Name and CD 
Key exactly as printed. Follow the on screen instructions to continue the DTM 
Installation to completion.

The installer, at the end of the DTM installation, will prompt for a machine 
restart. Restart the machine for the DTM to install and register successfully.
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8. Once the DTM installation is complete, a screen similar to the one shown in 
Figure 72 is displayed, with a summary report of the restore process. Errors if 
any, during the restore process, are displayed in the report.

Figure 72. Restore Process Summary Report

Click on the Exit button to complete the object type restore process.

SMS and e-mail Messaging

Introduction 

The procedure in this section is required to correctly configure SMS and e-mail 
Messaging in the Service Structure.

Configuring the Location

1. Open a Asset Master Workplace.

2. Use the Structure Selector to open the Service Structure
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3. Use the Object Browser to navigate to:

Services > Messenger Server, Service > Messenger SG_1,

Service Group > Messenger SP_1, Service Provider

4. Select Service Provider Definition in the Aspect List Area.

5. Under the Configuration tab in the Preview Area:

a. Select the Asset Master Node: drop-down list box

b. Enable the Enabled check box and click Apply.

c. Verify that the Current field (below the Enabled check box) changes from 
Undefined to Service.

Restarting the Event Collector Service

The following steps need to be performed to see events in Messenger Event Log:

1. Use the Structure Selector to open the Service Structure.

2. Use the Object Browser to navigate to:

Event Collector,Service > ABB 800xA System Message Server,Service 
Group > Event Collector_ABB 800xA System Message 
Server_NodeName, Service Provider

where NodeName is the Asset Master node.

3. Select Service Provider Definition in the Aspect List Area.

4. Disable the Enabled check box and click Apply.

5. Enable the Enabled check box and click Apply.

6. This will restart the Event Collector_ABB System Message Server_NodeName 
service and the Messenger Event Log will display all events.
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Asset Optimization

Introduction

The Asset Optimization Functional Area includes:

• Asset Optimization.

• PC, Network and Software Monitoring.

After restoring Asset Master System, the following post installation procedures for 
Asset Optimization are premofmed.

AoWebServerNode

The following steps are required to correctly set the Asset Master Node.

1. Open a Asset Master Workplace.

2. Use the Structure Selector to open the Control Structure.

3. Use the Object Browser to navigate to:

Root, Domain > Asset Optimization, Asset Optimization

4. Select Asset Optimization Configuration Properties in the Aspect List Area.

5. In the Preview Area, set the AoWebServerNode property to the name of the 
Asset Master node. 

Asset Monitoring Service Provider Node

The following steps are required to correctly set the Asset Monitoring Service 
Provider Node:

1. Open a Asset Master Workplace.

2. Use the Structure Selector to open the Service Structure.

3. Use the Object Browser to navigate to:

Services > Asset Monitoring, Service > AssetMonitoring SG_1, Service Group 
> AssetMonitoring SP_1, Service Provider

4. Select Service Provider Definition in the Aspect List Area.
3KXD151800R4401 107



Restarting the Event Collector Service Section 4  Post Installation
 

5. Set the Asset Optimization Service Provider node to Asset Master Node.

6. Enable the Enabled check box and click Apply. This will set the Service 
Provider hostname.

7. Use the Structure Selector to open the Control Structure.

8. Use the Object Browser to navigate to:

Root, Domain > Asset Optimization, Asset Optimization > AO Server 1, AO 
Server 1

9. Select Asset Optimization Server in the Aspect List Area.

10. Verify that Service Status is Service, and that the Asset Monitoring Engine is 
running.

Restarting the Event Collector Service

The following steps need to be performed to see events in Asset Optimization Event 
Log:

1. Use the Structure Selector to open the Service Structure.

2. Use the Object Browser to navigate to:

Event Collector,Service > ABB 800xA System Message Server,Service Group > 
Event Collector_ABB 800xA System Message Server_NodeName, Service 
Provider where NodeName is Asset Master Node.

3. Select Service Provider Definition in the Aspect List Area.

4. Disable the Enabled check box and click Apply.

5. Enable the Enabled check box and click Apply.

6. This will restart the Event Collector_ABB System Message Server_NodeName 
service and the Asset Optimization Event Log will display all events.

Web-Enabled Views on Non-Industrial IT Systems

The software requirements on non-Industrial IT systems required to support web-
enabled Asset Optimization views are:

• Internet Explorer 6 or later.
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• MS XML 3.0 with Service Pack 2 or later.

The maximum security settings on non-Industrial IT systems required to support 
web-enabled Asset Optimization views are:

• Set Local Intranet security to High.

• Select Custom Level and set the following:

– Download signed ActiveX® controls: Prompt.

– Run ActiveX controls and plug-ins: Enable.

– Script ActiveX controls marked for safe scripting: Enable.

– Active scripting: Enable.

SAP/PM Integration

The Asset Optimization integration with the SAP/PM module requires that the SAP 
administrator install ABAP code on the SAP/PM production server where the PM 
module is installed.

1. Navigate to the directory where Asset Optimization software is installed.

2. Use Windows Explorer to locate the following directory: ...\Asset 
Optimization\SAPConnectivity\SAP-ABAP

3. This directory contains the source for ABB’s ABAP integration code and 
documentation that describes the ABAP code integration. 

The ABB ABAP integration code source files are:

– Z_ABB_EQUIPMENT_DETAIL.ABAP.doc

– Z_ABB_MS_LIST.ABAP.doc

Accessing the Asset Optimization thin client interface always requires user 
authentication for Asset Optimization web pages.

To access Maximo portal views, set Microsoft VM to High Safety and Scripting 
of Java™ applets to Enable.

Maximo Portal views are web access into the Maximo system. They work best 
with versions of the Java Virtual machine at least as new as J2SE 1.4.2 (Java 2 
SDK and Java 2 Runtime Environment).
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– Z_ABB_NOTIFICATION_CREATE.ABAP.doc

– Z_ABB_NOTIFICATION_LIST.ABAP.doc

– Z_ABB_OBJECTSTATUS_LIST.ABAP.doc

– Z_ABB_WORKORDER_LIST.ABAP.doc

– Z_ABB_WORKORDER_HIST1.ABAP.DOC

Reference documents include the following:

– SAP RTAO Development.doc

– Z_ABB_PM_FunctionGroup-Modules.doc

Refer to the SAP/PM Basis and ABAP integration personnel for details involving 
the addition of ABAP-enabled interfaces in SAP.

DMS Calibration Integration

This topic covers the post installation tasks required when using DMS Calibration 
Integration.

DMS Software Users Configuration

Asset Master users must also be configured in the DMS software. Configure all 
Asset Master users in the DMS software who require access to DMS information, 
including the Asset Master Service User. Refer to the Meriam Process Technologies 
User Guide Device Management System instruction for information on configuring 
users.

DMS Server Configuration on non-Asset Master Node

If the DMS Server is installed on a non-Asset Master node, additional Asset 
Optimization software components are required.

If using the non-21 CFR Part 11 version of the DMS software, a prompt will 
appear asking that a password be entered, even for domain users. This is due to 
creating a DMS account to use if logging into the DMS client without using 
Windows Integrated Security. This password does not need to match the 
Windows password and must be between four and ten characters.
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1. From the DMS Server node, navigate to the Asset Viewer web page at: 
http://<Asset Master>/abbao.

2. If prompted to accept the Asset Viewer ActiveX component, accept it. This 
component is required for connection to the DMS Server.

Changing the DMS Server Location

The DMS Server location is defined by the DMS Server URL configured in the 
DMS client. In the rare case where a DMS Server must be moved, the location must 
be changed for all DMS clients on all nodes, and the Asset Master must be rebooted. 
Refer to the Meriam Process Technologies User Guide Device Management System 
instruction for information on changing the URL. In addition, the location must be 
changed in each of the Division aspect that refer to that DMS server.

Internet Explorer Configuration

1. Use standard Windows procedures to access the Local Area Network (LAN) 
Settings dialog.

2. If proxy configuration is enabled, enable the Automatically detect settings 
check box.

Excel Initialization

The following procedure is necessary if using the XY Profile Deviation Asset 
Monitor.

1. Use the Asset Master Service User account to open Microsoft Excel at least 
once.

2. Perform the required user setup (first time execution installation user initials).

Failure to perform the required Microsoft Excel user setup when using the XY 
Profile Deviation Asset Monitor may cause the AO Server startup to fail.
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PC, Network and Software Monitoring

Introduction

This section describes the actions necessary to set up the Basic Computer 
Monitoring functionality of PC, Network and Software Monitoring.

Basic Computer Monitoring

To set up the OPC Data Source Definition aspect:

1. 1. Use the Structure Selector to open the Control Structure.

2. Use the Object Browser to navigate to and select IT OPC Server Network in 
the Aspect Object Area.

3. Right-click on OPC Data Source Definition in the Aspect List Area and select 
Config View from the context menu that appears.

4. Click New in the Preview Area.

5. Click Add and select the appropriate service provider from the list.

6. Click OK twice.

7. Click Apply.

In order to create and configure the Basic Computer Monitoring functionality the 
Basic Computer Monitoring Configuration Tool must be run.

1. Select:

Start > All Programs > ABB Industrial IT 800xA > Asset Optimization > 
PC, Network and Software Monitoring > Basic Computer Monitoring 
Configuration Tool to launch the Basic Computer Monitoring Configuration 
Tool.

2. Click Start. The application will automatically close when it is completed.

Normally only minor configuration changes are required after the software is 
installed and the Basic Computer Monitoring Configuration Tool is run. The default 
alarm limits are expected to be suitable in most situations. In some cases it may be 
necessary to modify the hard drives that require monitoring. Changing the alarm 
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limits and the hard drives being monitored is done in the Basic Computer Device 
aspect shown in Figure 73. 

Figure 73. Basic Computer Device Aspect

Device Library Wizard

Introduction

This section describes post installation procedures for the Device Library Wizard. 

Device Library Wizard Server Settings

Perform the following procedure on all Asset Master.

1. Open the Device Library Wizard:

Start > All Programs > ABB Industrial IT 800xA > Device Mgmt > ABB Device 
Library Wizard

- OR -

double-click the ABB Device Library Wizard shortcut on the Desktop.
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2. When the Device Library Wizard main window opens, select Device Library 
Wizard Settings and click Next.

3. Select Server Setting and click Next.

4. Enter for the system node name or IP address of Asset Master. Click Next 
when complete.

5. Successful connection is indicated by the Configuring server settings is 
completed! entry in the logger area of the Finish Operation dialog. Click Next 
and follow the wizard to complete and exit from the configuration process. 
Close the Device Library Wizard by clicking Exit.

The path to the log file is:

<Installation path>\ABB Industrial IT\Engineer IT\ABB Device 
Integration Library\DLW.log

Device Type Preparation (Optional)

Perform the following steps at the point of time the Device Types to be used in the 
Asset Master are known. 

1. Open the Device Library Wizard from the Windows start menu or double-click 
the ABB Device Library Wizard shortcut on the Desktop.

2. When the Device Library Wizard opens select Extract Device Types and click 
Next.

3. Click Browse and navigate to the corresponding folder that contains the 
specific Device Type files.

It is only possible to work with Device Types using the Device Library Wizard 
after successfully completing the server node settings configuration.

The Device Library Wizard generates a log file. To view the contents of the log 
file click View Log in the Device Library Wizard dialog.

Device Type files are zip files (.zip) or self extracting zip files (.exe).

Select the Device Type files available on local disk and/or local network and 
extract them. It is not mandatory to copy all the Device Type files to the local disk 
before extracting them.
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4. Select the Device Type files (multiple selection is possible) and click Open.

5. Click Next and then Finish to start the extracting operation.

6. Repeat Step 3 to Step 5 as required for all required Device Type files.

7. Click Exit to close the Device Library Wizard.

Asset Master Installation DVD2 contains a range of Device Type files released 
for the Asset Master. All released Device Types can also be downloaded from 
ABB Solutions Bank at:

http://solutionsbank.abb.com/sbhome/

It is recommended to read the corresponding release notes to the Device Types. 
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Appendix A  Terminology

It is recommended that you familiarise yourself with the following list of terms: 

Table 6.

Term Description

ActiveX ® Microsoft ® standard for user interface components, 
based on definition of software interfaces.

AO Asset Optimization.

Asset Master 
Workplace

Provides a user interface for maintenance personnel to 
support their daily workflow most efficiently.

Asset Monitor Application responsible for retrieving data from, and 
interacting with, multiple data servers, OLE for Process 
Control ® (OPC®) servers, etc.). It analyzes the data 
and when necessary, issues an Asset Condition 
Document and notifies the user of the detected 
condition.

Aspect Object A computer representation of real objects such as 
pumps and valves or a number of virtual objects such as 
service or object type. An Aspect Object is described by 
its aspects and organised in structures.

Distributed COM 
(DCOM)

Remote Procedure Calls to enable distributed 
component objects to communicate with each other.

DMS Device Management System (DMS) database software. 
Provides calibration and configuration management 
through the companion DHH810-MFT Series 
Calibrator/HART Communicator, and DHH800-MFC 
HART Communicator.
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Fieldbus Builder (FBB) ABB aspect system for fieldbus and DTM management, 
implementing a Frame Application according to 
specification FDT 1.2

Fieldbus Builder FF 
(FBB FF)

The system extension that owns and stores all 
FOUNDATION Fieldbus relevant data and the business 
logic belonging to it. The FBB FF exposes its objects 
through an automation interface.

FOUNDATION Fieldbus 
(FF)

Bi-directional communications protocol used for 
communications among field instrumentation and control 
systems.

IndustrialIT Industrial IT is ABB’s solution for business processes. It 
allows seamless integration of systems for plant 
automation, plant optimisation and common business 
processes at run time.

Node A computer communicating on a network e.g. the 
Internet, Plant, Control or I/O network. Each node 
typically has a unique node address with a format 
depending on the network it is connected to.

PC Personal Computer. Computer running the Windows 
operating system.

Security Security controls a user’s authority to perform different 
operations on Aspect Objects, depending on several 
parameters:
• The user’s credentials, as provided by Windows
• The node where the user is logged in. This makes it 

possible to give a user different authority depending 
on where he/she is located, e.g. close to the 
process equipment, in a control room, or at home 
accessing the system through Internet.

• The object the user wants to perform the operation 
on.

Table 6.

Term Description
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Server A node that runs one or several Services.

Structure A hierarchical tree organization of Aspect Objects that 
describes the dependencies between the real objects. 
An Aspect Object can exist in multiple structures, for 
example both in a Functional Structure and in a Location 
Structure.

View Aspects can be presented in a number of ways 
depending on the task performed e.g. viewing or 
configuration. Each presentation form is called a view.

Table 6.

Term Description
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